EM-PB-GATEWAY-IFS

Application note for the EM-PB-GATEWAY-IFS and
STEP 7 software

Application note
104303 _en_01 © PHOENIX CONTACT 2011-11-08

1 Description

Startup Diagnostics/maintenance Control system (PLC)

The EM-PB-GATEWAY-IFS is a module which enables o o ik
connection of the EMM...IFS modules and PSR-TRISAFE to D i
the PROFIBUS-DP. The module is certified in accordance (= J Al
with the DPV 1 specification (EN 50170). @

The EM-PB-GATEWAY-IFS can communicate via the

TBUS with up to 32 EMM...IFS modules. 8 digital inputs and
4 outputs can be freely parameterized.

The EM-PB-GATEWAY-IFS also supports Fail Safe: as the
switching behavior can be influenced by the
parameterization in the event of PROFIBUS errors. Digital e

-PB gateway EM-PB gateway + EMM ... IFS 1
switching outputs allow direct control of the EMM...IFS +EMM .. IFS up to EMM ... IFS 31, EMM ... F'S 32

(forward/feverse Funning). Figure 1 PROFIBUS gateway for electronic motor
The GSD file (containing the communication characteristics management modules

of a PROFIBUS-DP device) can be found on the Internet at
www.phoenixcontact.net/catalog.

Make sure you always use the latest documentation.

It can be downloaded at www.phoenixcontact.net/catalog.
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2 Downloading the GSD file 3 Operating and indication elements
of the EM-PB-GATEWAY-IFS

1. Access the Phoenix Contact Online Catalog

(www.phoenixcontact.net/catalog) and search for
"EM-PB-GATEWAY-IFS" or "2297620".

2. Select "Downloads".

Information on this item

B
:
Z
g
é
v

ftem homepage » Catalog Extract (PDF > 8

W @

[+

Figure2 Selecting downloads in the Online Catalog

3. Click on the GSD file "PXC_0B51.gsd".

Seftware - Figure 6  Operating and indication elements
Description Language Revision File size [bytes] Type
I GSD file for EM-PB-GATEWAY-IFS Internatio  1.02 19028 gsd @ Button fOI’ Sett|ng the PROFIBUS address
| CONTACTRON-DTW-IFS setup (DTM version 3.14, Automation German  1.003.14 83165367 zip @ Status LEDs
Xplarer, USB driver) English
Figure 3  Selecting a GSD file in the Online Catalog i ;;eosl‘:t?éfsl‘:zs;:g zigigﬂrgfi?g??h?e

connected IFS devices in parameterization mode

4. Read the General Terms and Conditions of Use. . .
during the address setting process.

5. Click "Accept" to confirm that you agree with the
General Terms and Conditions of Use.

Before downloading the files, please accept the 4 Add I‘eSSI ng example
General Terms and Conditions for Use of Internet Downloads
[eceent] | [ICiose window] CPU
Figure4 General Terms and Conditions of Use 4
6. Save the GSD file by clicking the "OK" button. / L PROFIBUS address: 4
PROFIBUS address: 2
1IFS i

You have chosen to open

1 1

1

: : '
[ Pxc_oB51.9sd i !
which is a: gsd File ! — :
from: http:{/select. phoenixcontact.com : i
: i

1 1

i 1

1 1

What should Firefox do with this file?

O o

(3 Save File

IFS address: 2
IFS address: 1

Figure7  Addressing example

L OK J [ Cancel

Figure 5  Saving the GSD file The PSR-TRISAFE-... module must be assigned

[ ]
1 the IFS address1.
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($)}

Setting the PROFIBUS address at
the EM-PB-GATEWAY-IFS

Press button (1) (see Figure 6 on page 2) at the
EM-PB-GATEWAY-IFS for 6 seconds.

The LEDs (2) atthe EM-PB-GATEWAY-IFS display the
current PROFIBUS address offset.

Set the PROFIBUS address offset by pressing the button
(1) atthe EM-PB-GATEWAY-IFS (see table).

Press button (1) at the EM-PB-GATEWAY-IFS for
6 seconds.

i

The EM-PB-GATEWAY-IFS calculates the
PROFIBUS address by adding the offset to the

base address.

The base address is setto 0 by default and can be
modified by means of (DTM) or IFS-CONFSTICK
software.

PWR

LED code
DAT | ERR

Offset
BF | SF

Default offset

o|Oo|Oofofjo|o|o|o

0
1
2
3
4
5
6
7
8

o|lo|o|o|o|o|o|o|o|o|ojoo(o|o|o

9
10
11
12

6 INTERFACE system addressing

1. Press button (1) at the EM-PB-GATEWAY-IFS for
12 seconds.

2. ThelLEDs (2) atthe EM-PB-GATEWAY-IFS display the
current IFS address of the first device on the IFS-Bus.

3. Set the IFS address by pressing the button (1) at the
EM-PB-GATEWAY-IFS (see table).

4. Press the button on the first device e.g.
EMM...IFS = Reset button
TRISAFE = Confirmation button

5. The IFS address is applied at the first device.

6. Atthe EM-PB-GATEWAY-IFS, the address of the next
device is displayed. Repeat steps 3 and 4 until all
devices have been addressed.

7. Press button (1) at the EM-PB-GATEWAY-IFS for
12 seconds.

8. Allstatus LEDs light up briefly.

LED code IFSM
PWR| DAT | ERR | BF | SF | address

0 0 0 0 0 0
0 0 0 0 1
0 0 0 0 2
0 0 0 3
0 0 0 0 4
0 0 0 5
0 0 0 6
0 0 7
0 0 0 0 8
0 0 0 9
0 0 0 10
0 0 11
0 0 0 12

0 0 13

0 0 14
0 15
0 0 0 0 16

0 0 0 17

0 0 0 18

0 0 19

0 0 0 20

0 0 21

0 0 22

0 23

0 0 0 24

0 0 25

0 0 26

0 27

0 0 28

0 29

0 30

31
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7 Integration in STEP 7
1. Start SIMATIC Manager

SIMATIC
Manager

Figure 8 SIMATIC Manager icon

2. Create a new project

ySIMATIE Manager - [Test Alex2_281009 -- C:\Siemens'\Step7\s7proj\Test_A_3]
ile Edit Insert PLC View Options Window Help

Ctr+N < No Filter »
lew Project Wizard...

Open... Ctr+0
Open Yersion 1 Project...

Close

bl |

Multiproject »

57 Memory Card »
Memory Card File »

Save As... Ctr+5

Figure9 Creating a new project

3. Assign project name and click "OK"

New Project x|

User projects I Lihrariesl Multiprojects |

Name l Storage path -
@ kafdzui C:ASiemens\Step7\s7proj\kafdzui
@ S7_MR_28082009_1 C:ASiemens\Step7hs7proj\S7_MRA_™1
@ S7_Prol C:A\Siemens\Step7\S 7proj\S7_Prol
@ S7_Pro2 C:ASiemens\Step7\S7proj\S7_Pro2 o
@ S7_Pro3 C:A\Siemens\Step7\s7proj\S7_Pro3
@ S7_Prod4 C:A\Siemens\Step7\s7proj\S7_Prod
@ S7_ProS C:ASiemens\Step7\s7propS7_Pro5
%Tnn' Aleas A Clmrmmina! ACharn T\ aTmeaid Tank Als ;I

I™ Add to current multiproject

Name: Type:
ITeslploiecl I Project ¥ I
I™ | F Library

Storage location (path):
IC:\Siemens\Slep?\s?ploi

Browse... |
ok | Cancel | Hep |

Figure 10 Saving project name

4. Under the menu command "Insert" > "Stations", select
the appropriate CPU.

QSIMATIC Manager - [Testproject -- C:\Siemens'\Step7',s7proj',T

B File Edit | Insert |

PLC View Options Window Help

1 SIMATIC 400 Station
Ma

3 SIMATIC H Station
S 4 SIMATIC PC Station
N S Other station
\ 6 SIMATIC 55
7 PGIPC
Text Library. >

Externial Source..,

1

Figure 11 Selecting the CPU

5. The selected CPU is inserted into your project.

QSIMATIC Manager - [Testproject -- C:\Siemens'Step7's7proj' Testproj]

@ File Edit Insert PLC View Options Window Help

D] 837 & ||e| bl [o 2| )+
1278 T estproject B SIMATIC 300(1)

SIMATIC 300(1)

Figure 12 Selected CPU

6. Open the context menu of the inserted CPU.
Click on "Open object".

Q SIMATIC Manager - [Testproject -- C:\Siemens'\Step7\s7proj'\Testproj]

@Fk Edit Insert PLC View Options Window Help

< NoFilter >

Dl £l (ol (o %) 4S5
5138 Testog; = PHaldwam

SIMA 0(1

Open Object Ctrl+Al+0
Cut Chrl+X

Copy Ctri+C

Paste GErl+Y.
Delete Del

PLC »
Print »
Rename F2

Obiject Properties... Alt+Return

Figure 13 Opening the object
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7. The hardware configuration is displayed.

,,,,,,,,,,,, _EN =1oi ]
window Heb 1ol x|

Sl slel G ]
e i

Eofie:  [Standare

BEBRORELS DP
£ PrROFBLS PA

SMATIC300

SMATIC400

‘SIMATICPCBased Control 0/400
SIMATICPC Stafon

TEEE | )

-1 le
4% smatic 300p)

i Desnain |

,7mnmusopmmsmn:s1,
|N7. and C7 (dstriuted 1ack) E]

10. Now load the GSD file downloaded in chapter 2.

11. If the "Installation has been completed successfully"
message appears, you can close the hardware editor.

x|
Install GSD Files: I&vom the directory El
|C:AD: und Einstell CL ktop Browse ... I
Install GSD File (13:4986) x|
\i) ion was

|EMPBJGATEWAY-IFS

fres i toget i, T Z

Figure 14 Hardware configuration

8. Close all application windows.

élgl el B 22wl

2|2 (&)

Figure 15 Hardware configuration

9. Open the "Options" menu and select the "Install New
GSD..." command.

:[;HW Config: Configuring hardware

Station PLC View | Options Help

Dlﬁ-lewlg |q Customize. ..
Edit Catalog Profile
Update Catalog

Ctr+-Alt+E

5 4

Find in Service & Support...

Figure 16 Installing a GSD file

Instal | ShowLog Select Al Deselectall |
o= | L
Figure 17 "Installation has been completed successfully"
message

12. Open the context menu of the inserted CPU.
Click on "Open object".

g@SIMATIE Manager - [Testproject -- C:\Siemens'\Step7's7proj' Testproj]

B8P File Edt Insert PLC View Options Window Help

Dl 22| #|5|e] sl [0 2a] 2af> S| @] [Norer

Hardwae,

SIMATIC 300(1
Paste Gl
Delete Del
PLC »
Print »
Rename F2
Object Properties... Alt+Return

Figure 18 Opening the object
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13. Open the "View" menu and then select "Catalog”. 71 Example with SIMATIC 300
[ Hw Config - [SIMATIC 300(1) (Configuration) -- Testproject] 1. Select "SIMATIC 300" — "RACK 300" — "Rail" and
@By station Edit Insert PLC | yiew Options ‘Window Help insert this into your project.

D22 % o IS x|

ress Uverview...

Filter » Eind: I L’Iﬂl

v Toolbar Profile: ISlandard ll
i ol PROFIBUS DP
Update FS RUS-FA
Auto Arrange F4 C 300
{3 CP-300
(3 cPU-300
Figure 19 Selecting the catalo (1 FM-300
. g 9 {1 Gateway
. {3 IM-300
14. The catalog window appears. {21 M7-EXTENSION
_ {1 PS-300
I =lolx| 5.C_BACK.
=181 %
P
S | _Ij SIMATIC 400
Profile:  [Standard - L2 SIMATIC PC Basled Control 300/400
B, SIMATIC PC Station
282 PROFIBUS-PA
# SIMATIC 300
# SIMATIC 400 I

SIMATIC PC Based Control 300/400

R ISIETICRE Stadon Figure 21 Selecting the DIN rail

2. Select "SIMATIC 300" — "CPU 315-2 DP"
— "6ES7-315-2AF03-0AB0" — "V1.2" and insert this
into your project.

J Profile: IStandard EI

| %? PROFIBUS DP

-

| = @ SIMATIC 300

3 cP300
=1 CPU-300

&3 cru 312

(2 CPU 312IFM

(3 crPu3tC

£ crPu 313

(3 cPU3I3C

(I3 CPU 313C-2DP

(] CPU 313C-2 PP

X (1 CPU 314
_'LI (3 CPU 314 1FM
B (] CPU 314C-2DP
(3 CPU 314C-2 PP

) . {1 CPU 315
Figure 20 Catalog window =] CPU 3152 DP

PROFIBUS-DP slaves for SIMATIC 57,
M7, and C7 (distributed rack)

Y

-2 00-048
15. Suitable devices must now be inserted into your project GES7 315-24F01-048
here. BES7 315-24F02-048
=-{] BES7 315-24F03-048
Figure 22 Selecting the CPU
104303_en_01 PHOENIX CONTACT 6
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3. The "Properties" window appears.
Click "New" and enter a new name for the bus line.

5. The "Properties" window appears.
Under "Address", you must select the address which
was configured in the EM-PB-GATEWAY-IFS in
chapter 4.

[Properties - PROFIBUS interface DP (R0/52.1). x| B 70
=0 Gateway
P: ter
Ganeial | Pasneies] &g DP/DP Co
Addese = - gg DP/RS232(
= | 5 claroe,
el B3 | * EM-PB-GAT
arameters
_’11 =0 cu3I520P e - DP/DP Col
Subnet: b 6ES7 31524F00.048 Q0 PLe
— 6ES7 315:24F01-048 Address: 2 J#-0 Compatible PRI
BES7 315:24F 02048 5 CiR-Object
Giiaraian | Potes. | L =0 5‘5\;‘3:‘52'” Lo - [ Closed-Loop Contro
| = Vi1 Transmission rate: 1.5 Mbps L1 Configured Stations|
== Ji viz [1 DP VO slaves
| | i g BES7 315:24F 82048 || Subnet L) DP/AS
® . 6
S — 5 B o omaroond New [ DP/PA Link
PO — [ &3 CPU315F-20P | ] ENCODER
i u Propetties... [ ET 2008
[ — - Order number
— o | | ' i o T
elete [ ET 200eco
| | BES7 315-2% L] ET 200i
L] ET 2000
L] ET 200M
L] ET 200R
L] ET 2005
[6E57 315-2AF 03,008 2] %,
fork memoty 64 KB: 0.3 ms/1000 _(j T Ll E; gggg
instructions; MPt DP connection ]
e e | | Cancel Help L] Function Modules
T o 4 IDENT
[ | | | | =@ IPC
I | I I | @ QN
A~ SE—

Figure 23 Bus line name

4. Select "PROFIBUS-DP" — "Additional Field Devices"

— "Gateway".

Now move the EM-PB-GATEWAY-IFS into your project.

FEind:

Profile: I Standard

= PROFIBUS DP
{1 Additional Field Devices

-1 1/0

=] Gateway

@ PLC
(L] Compatible PROFIBUS DP Slaves
0 CiR-Object
{1 Closed-Loop Controller
(L] Configured Stations
(L] DP VO slaves
{1 DP/ASH
{1 DP/PA Link
{_] ENCODER
{1 ET 2008
{1 ET 200C
(L ET 200eco
(L ET 200i5
{1 ET 200L
(L] ET 200M
{1 ET 200R
{1 ET 2005
{21 ET 200U
{1 ET 200%
{1 Function Modules
{2 IDENT
{Irc
{anNC
{1 Network Components
{1 Sensoric

{1 SIMADYN
.7 CIMATIC

H

Figure 24 Selecting the gateway

Figure 25 Gateway properties

6. You can now move the required GSD data into your
project from the Catalog window under the
"EM-PB-GATEWAY-IFS" item.

(21w Config - [SIMATIC 300(1) (Configuration) -- Testproject]

.SlaﬁmEdtlnsevtPLcViewOptimsWiﬁowHeb

DlE(e- (% & el bl [@o] 8 |

| |

4=/ mp| simaTiC 30001)

Slot | Designati
UR

'ROADP master system (1)

I
Figure 26 GSD data

104303_en_01

-

PHOENIX CONTACT 7

*»  RSPSupply - 1-888-532-2706 - https://www.RSPSupply.com
See the product details here


https://www.RSPSupply.com
https://www.rspsupply.com/p-69139-phoenix-2297620-gatewaysproxies.aspx

EM-PB-GATEWAY-IFS

8 Setting: byte order

1. Open the context menu of the EM-PB-GATEWAY-IFS
and select "Object properties".

2. Activate the "Parameter Assignment" tab.

"Mastersystem (1]

propertes -Dpaiave ——— S =SS g
General Parameter Assignment l
Parameters ‘ Value -

—[Z] DP Interrupt Mode rﬁlﬁlo

Jﬁ&] General DP parameters

EH
*i] IFS Application : ELR, EMM
[Z] Byte order : Motorola E'
I-[Z] Behaivor at Profibus error : Motorola
—[Z] OUTPUT 1 controled by :
[£] OUTPUT 2 controled by : Profibus
I-[] OUTPUT 3 controled by : Profibus
~[£] OUTPUT 4 controled by : Profibus
~[£] Real power [W](* 0.001) 1000
—[Z] Reactive power [var](* 0.001) 1000
[£] Power [vA](* 0.001) 1000
—[£] voltage [v](* 0.001) 10000
(] Current [A](* 0.000001) 100000
[£] Switchcycles (* 0.000001) 1000000
—[Z] Operatioon time [h](* 0.000001) 100000000 e
[Z] Energy [kWh](* 0.000000001) 1000000
[£] Userdefined 1 (* 0.000001) 1000000 j

Cancel Help |

Figure 27 Setting the byte order

3. The byte order of the transferred data can be set here
under "Device-specific parameters" by selecting

"Byte order".
Motorola: Big Endian (the most significant byte is saved
first of all)
Intel: Little Endian (the least significant byte is saved
first of all)

8.1 Example: "EMM: COS ¢" value

Motorola Intel
Statuswert lStatuswert |
WMSM_D(I WH16H0E4D _
oEap - 3661
A T
Cos ¢ =0.3661

Figure 28 Example: "EMM: COS ¢" value

9 Explanation of GSD data

° A detailed description can be found on the
1 package slip of the EM-PB-GATEWAY-IFS,
which is provided with the product.

The package slip can also be downloaded from the

Phoenix Contact Online Catalog.

1. Access the Phoenix Contact Online Catalog
(www.phoenixcontact.net/catalog) and search for
"EM-PB-GATEWAY-IFS" or "2297620".

2. Select "Downloads".

Information on this item

ftem homepage » Catalog Extract (PDF » St

Figure 29 Selecting downloads in the Online Catalog

3. Click onthe "packb_em_...pdf" package slip.

Package Slip a
Description Language \ Revision | File size [bytes] l Type ‘

I Order no. 9039888: PACKB.EM-PB-GATEWAY-IFS Multi 00 745285 pdf
PROFIBU: fir INTERFACE: /PROFIBUS

coupler for INTERFACE system devices

Figure 30 Selecting package slips in the Online Catalog

4. Save the pdf file or open if you wish to view the file.

9.1 GSD data for EM-PB-GATEWAY-IFS

Universal module

Digital inputs, outputs

Gateway: Module state

Gateway: Channel State 1

Gateway: Channel State 2

Gateway: Channel State 3

Gateway: Channel State 4

IFS: Slave Error State 1

IFS: Slave Error State 2

IFS: I/O State 1

IFS: I/0O State 2

104303_en_01
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9.2

GSD data for EMM ...

ELR, EMM Objects

EMM:

Control (Device:1

—— 1=IFS address 1

EMM:

Control (Device:2

—— 2 =IFS address 2

EMM:

Control (Device:3

—— 3 = IFS address 3

EMM:

Control (Device:4

—— 4 = IFS address 4

EMM:

Control (Device:5

— 5 =IFS address 5

EMM:

Control (Device:6

— 6 = IFS address 6

EMM:

Control (Device:7

—— 7 =IFS address 7

EMM:

Nut2 BNED N BN BN IRaol B2 BN BN

Control (Device:8

HAHAA

— 8 =IFS address 8

EMM:

Status

EMM:

Module State 1

EMM:

Module State 2

EMM:

Channel State 1

EMM:

Channel State 2

EMM:

Channel State 3

EMM:

Channel State 4

EMM:

P(ALL)

EMM:

u(L1)

EMM:

u(L2)

EMM:

U(L3)

EMM:

I(L1)

EMM:

I(L2)

EMM:

I(L3)

EMM:

Electric Work

EMM:

COS PHI

EMM:

Frequency

EMM:

Operation time (left)

EMM

: Operation time (right)

EMM:

Cycle (left)

EMM

: Cycle (right)

EMM:

P(L1)

EMM:

P(L2)

EMM:

Q(ALL)

EMM:

S(ALL)

EMM:

SQRT(3) * U(L1)

EMM:

SQRT(3) * U(L2)

EMM:

SQRT(3) * U(L3)

i

9.3 GSD data for PSR-TRISAFE-S

TriSafe Objects

PSR-TS-S : Device 1 <@——1 =IFS address 1

PSR-TS-S : Input 15 .... 0 e pus
To.a- | Safeinputs:

PSR-TS-S : Input19 ... 16 - H6 .. 119
To.a- | Safe outputs:

PSR-TS-S : SafeOut 3 ... 0 <*—_ 03

PSR-TS-S: UnSafeOut15...0 —a—— Monitoring

outputs: MO ... M3

If a PSR-TRISAFE is used, the IFS address 1
must not be assigned to an EMM.

9.4 GSD data for PSR-TRISAFE-M
TriSafe Objects
PSR-TS-M : Device 1 ~@t——1 =IFS address 1
PSR-TS-M : Safe IN w01 e Pt
PSR-TS-M : Safe IN w02 <ot
. | Safe outputs:
PSR-TS-M : Safe OUT w01 - 03
Diagnostic LEDs:
PSR-TS-M : Diag IN w03 <@——PWR, DATA,
ERR, CONF
Monitoring
outputs: MO ... M3
PSR-TS-M : None Safe OUT w01 <s&——and external
signals:
EQO0,... EQ11
PSR-TS-M : None Safe OUT w02 <&— £a°7'® 2909
PSR-TS-M : None Safe OUT w03 a— o0 S92
PSR-TS-M : None Safe OUT w04 <a—— oo S0l
PSR-TS-M : None Safe OUT w05 ~&— o™ 2909
° The "EMM: Control (Device: X)" control word is
1 used simultaneously for assigning the values

listed below to a suitable IFS address of the EMM

to be addressed.

e Should you wish to integrate values from the
EMM with the IFS address 1, the
"EMM: Control (Device:1)" word must be
inserted into the structure first of all.

All the words inserted there now relate to the
EMM 1, until another control word is inserted with
a different address.
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10
The

10.2

Example

following modules are used in this example:
SIMATIC S7-300

EM-PB-GATEWAY-IFS

EMM 3-24DC/500AC-16-IFS
PSR-SCP-24DC/TS/S

Applied GSD values

Order Number / Designation

10.1 Hardware structure
CPU
4

/ 1]

PROFIBUS address: 2

PROFIBUS address: 4

Digital inputs, outputs

A

EM-PB-GW-IFS

Order Number / Designation

EMM : Control [Device:2)

EMM : Status

EMM : PALL)

EMM : Frequency

EMM : Dperation time(left)

EMM : Dperation time(right)

EMM : Cycle(left)

EMM : Cycle(right)

EMM : L[L1)

EMM : LU[L2)

EMM : LU[L3)

EMM : I[L1)

EMM : I[L2)

EMM - I(L3)

AMAAAAAAAAAAIAIL

Order Number / Designation

TriSafe : Device 1

TriSafe : Master Input 15..0

TriSafe : Master Input 19..16

TriSafe : Master SafeOut 3..0

TriSafe : Master UnSafeCut 15..0

WIAJAIAJA

Figure 31 Hardware structure

IFS address: 2
IFS address: 1

Inputs and outputs of the EM-PB-GATEWAY-IFS

Control word of the EMM, e. g. forward running, reverse running, stop,
Status word of the EMM, e. g. input state, direction of motor

Display: real power total
Display: frequency

Display: operating hours counter (reverse running)
Display: operating hours counter (forward running)

Display: cycles (reverse running)
Display: cycles (forward running)

Display: voltage L1
Display: voltage L2
Display: voltage L3
Display: current L1
Display: current L2
Display: current L3

Must be set (PSR-TRISAFE-S is assigned IFS address 1)

Display: safe inputs 10 ... 115
Display: safe inputs 116 ... 119
Display: safe outputs OO0 ... O3

Display: monitoring outputs MO ... M3
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EM-PB-GATEWAY-IFS

10.3 Monitoring variables

Properties - DP slave E x|

General Parameter Assignment | dentiication |

E;-,‘HW Config - [SIMATIC 300(1) (Configuration) -- Testproject]
mstation Edit Insert PLC View Options Window Help

D[e-2 % 8| =le| el [@o 8 el
Parameters Value
Be
1 PROFIBUS(1): DP master system (1) —E] DP Interrupt Mode DPYD
2 M T [#_] General DP parameters
;Q O | =2 | Pevice-specific parameters
[Z] IFS Application : ELR, EMM
; Byte .order : ] Intel
5 Behaivor at Profibus error : Reset outputs
7 OUTPUT 1 controled by : Profibus
) -[£] OUTPUT 2 controled by : Profibus
g [Z] OUTPUT 3 controled by : Profibus
10 -[Z] OUTPUT 4 controled by : Profibus
1 -[Z] Real power [W]( * 0,001 ) 1000
(2] Reactive power [var]( * 0.001 ) 1000
[Z] Power [vA]( * 0.001 ) 1000
[Z] voltage [v]( * 0.001 ) 100
(] Current [a){ * 0.001) 1
< | H[Z] Switchcycles (* 1) 1
-] Operatioon time [h]( * 0.001 ) 1
- -_bj (4) EM-PB-GATEWAY-FS o
Slat d Order Number / Designation | Address | Q Address | Comment
1_|_|i“2 [Digital inputs, cutputs 256,257 |256..257 0K I ﬂl M
130 [EMM : Control [Device:2) 258...259
2 e o Figure 33 Object rties of the EM-PB-GATEWAY-IFS
65 _[EMM: PIALL) 260..261 Igure JECt properties or the
5 66 |EMM : Frequency 262...263
B 6 : Operation time(left] 264...265 . 3
7|66 [EMM - Operstion tmefight 266..267 * Inthe object properties of the EM-PB-GATEWAY-IFS,
8 : Cyclefleft) 268...269 .
5 M Cyclfight] 270271 the conversion factors for the measured values can be
10 66 [EMM : U[L1) 272..273 ifi
1 66 [EMM : U[L2) 274..275 SpeC|fled
12 66 |EMM : U(L3) 276...277
13 3 [TriSafe : Device 1
14 B6 [TriSafe : Master Input 15..0 284...285
15 6 |TriSafe : Master Input 19..16 286...287
16 6 _|TriSafe : Master SafeQut 288...289
17 6 _|TriSafe : Master UnSafeOut 290...291
18
ik
Insertion possible

Figure 32 Opening the context menu of the
EM-PB-GATEWAY-IFS

Fhvar - vaT_1 -10] x|

Table Edit Insert PLC Variable View Options Window Help

#| D@ 8| &|®meo|o| ¥| 28] K| e 64]%| . o

5| S| < [Z] X ” = ¢ In the variable overview, individual values can now be
FlvAT_1 -- Testproject\SIMATIC 300(1)\CPU 315-2 DP\S7 Program(1) =10] x| .

Address | Symbol Display format| Status value Modify value dISpIayed.

[L [ PAW 258 "EMM: Control" HEX

2 _PEW 258 "EMM: Status" BIN .

5 [Pew 260 "EmM. PaLLY O = In the example image, you can see, for example, that the
[AR[ PEW 262 "EMM: Frequency” DEZ real power (All) amounts to 278 W.

5_ PEW 2547"EMM: Operation time (L) DEZ

6_ PEW 266 "EMM: Operation time (R)* DEZ

7 | |PEW 268 "EMM: Cycle (L]" DEZ

18 | PEW 270 "EMM: Cycle (R)" DEZ .

9| PEW 272 “EMM: U (L)' DEZ ° For each EM-PB-GATEWAY-IFS, a maximum of
10 PEW 274 "EMM: U (L2)" DEZ .

1] PEw 276 “EMM.U (31 B= 1 32 words can be transferred in the cycle (66 ms).
12| PEW 278 HEX

13| PEW 280 HEX

[14] [PEW 282 HEX

16] PEW 284 "TRISAFE: IN 150" BIN

E ) PEW 286 “TRISAFE: IN 1916" BIN

18] | PEW 288 "TRISAFE: Safelut" BIN

[19|  PEW 290 "TRISAFE: UnSafeDut  BIN

20 |
Press F1 for help. [ 2@ [offine  labs<t 4

Figure 34 Variable overview
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